
MasterTemplate 15 Release Notes 
 

© Eric Bobrow - July 20, 2011 
 
Welcome to the latest version of MasterTemplate - the Office Standard for ArchiCAD™. The new update 
provides full compatibility with ArchiCAD 15, and also contains new features and revisions based on 
feedback and suggestions from users as well as our own discoveries and innovations. 

This document explains the new features, and outlines strategies for users upgrading from earlier 
versions of MasterTemplate. 

We suggest you read through these Release Notes to see what's new, and then decide how you want to 
transition your own version of AMT. At the end of this document, various approaches will be discussed for 
how to integrate the new version of AMT with your previously customized template. 
Please report anything requiring cleanup in an email to support@actemplate.com. We hope you enjoy the 
new features of AMT 15. Thanks again for the opportunity to work with you! 
 
Eric Bobrow 
Bobrow Consulting Group 

 

CONTENTS 
Summary of Changes to AMT 15 
Initial Download and Setup 
Changes, Updates and New Features in MasterTemplate 15 

1. Interactive Legends and Favorites revised to use ArchiCAD 15 Library 
2. The MasterTemplate Library is now fully embedded 
3. Revised General Notes Word file and PDF 
4. Simplification of Title Sheet autotext blocks 
5. Integration of the new Renovation methodology for ArchiCAD 15 
6. Layer optimization 
7. Reworked Sample Project file 

Suggested Renovation Project Workflow 

UPGRADE GUIDE 

Options for Integrating MasterTemplate 15 with Your Existing Template  

1. How to Integrate Previous Customization into MasterTemplate 15 
2. Integrating the New MasterTemplate 15 Features into Your Highly Customized 

MasterTemplate 12.1, 13 or 14 File 
3. Migrating from MasterTemplate 12 or earlier	   
4. Technical Note on Library Management for Advanced Users 

 

 

 



Summary of Changes and New Features in MasterTemplate 15 
1) The AMT Legends as well as the Favorites palette elements were revised for compatibility with 

ArchiCAD Library 15. 

2) All custom library parts are now embedded into the template file, rather than loaded as linked 
libraries. 

3) The process of working with General Notes and Specifications has been simplified. The word 
processing document has been reconfigured so that each page in Microsoft Word represents one 
complete Layout sheet in ArchiCAD (with multiple columns) rather than being only a single column. 

4) The Project Data and Project Team areas on the Title Sheet have been reworked to make it simpler 
to edit by combining multiple small text blocks into larger integrated blocks with appropriate tabs and 
indentation. 

5) The new Renovation technology introduced in ArchiCAD 15 has been extensively integrated into 
MasterTemplate. This affected layers and layer combinations, drawings (particularly demolition 
plans), the interactive legends, definitions of composite wall types, and schedules. Older approaches 
based on Hotlinked Modules have been discarded in favor of the simplicity offered with the new 
methodology. 

6) Layers and layer combinations have been optimized based on user feedback and our own 
experimentation and analysis. 

7) The Sample Project file has been extensively reworked to showcase the new Renovation tools. In 
addition, all library parts have been swapped out for ArchiCAD 15 USA versions; in the International 
version of MasterTemplate, the USA library parts are embedded into the PLN to simplify access. 



Initial Download and Setup 
 
The AMT download zip file expands into the following files: 
 

• MasterTemplate 15 (USA / INT) TEMPLATE.tpl 
• MasterTemplate Linked Files folder: 

o AMT Layout Master Company Logo.jpg 
o AMT Legends (USA / INT) 15.pln 
o AMT Office Favorites (USA / INT) 15.pln 
o AMT Project Favorites (USA / INT) 15.pln 
o Master Specifications Full Page.doc 
o Master Specifications Full Page.pdf 

• MasterTemplate 15 INT LIBRARY (International version only) 
• AMT Supplemental Files folder: 

o AMT Work Environment folder 
o Library folder for optional use: 

 MasterTemplate 15 USA LIBRARY, or 
 MasterTemplate 15 INT LIBRARY (EMBEDDED) 

o MasterTemplate NEW PROJECT FOLDER 
• MasterTemplate 15 Release Notes.pdf (this file) 

 
The MasterTemplate 15 INT LIBRARY folder is loaded as a Linked Library folder by the template file (see 
explanation in item 2b above). It is placed at the top level, right next to the MasterTemplate 14 INT 
TEMPLATE.tpl file to make it easier to locate, since ArchiCAD will usually find linked libraries 
automatically when they are placed in the same folder as the project file.  
 
The libraries in the AMT Supplemental Files folder, the MasterTemplate 15 USA LIBRARY or the 
MasterTemplate 15 INT LIBRARY (EMBEDDED), do not normally need to be loaded in the Library 
Manger since the contents are embedded into the Legend files. However, for advanced users, these 
folders are provided as an alternative option. 
 
To install AMT 15, download the zip file to your workstation, then unzip to a convenient location into a 
new folder. We recommend placing this into your ArchiCAD Office Standards folder; a good place for this 
is in the Jobs or Projects folder on your hard drive or on the office server. 
 
The AMT 15 file uses three Hotlinked Modules (HLM): one refers to the AMT LEGENDS 15.pln (the main 
“kit of parts”), a second to the AMT Office Favorites 15.pln, and a third to the Project Favorites 15.pln. 
 
When you open up the TEMPLATE you'll get a message saying that these three Hotlinks are missing: 
 

 
 
This is to be expected, since all the files are now on a new workstation, and ArchiCAD doesn’t know 
where to find them. You should ignore this message and continue; you’ll clean it up after you finish 
opening the file. 
 
You will also get a warning about missing PDFs - these are referenced in the Layout Book and used for 
the specifications and general notes pages. As with all previous versions of AMT, it’s simplest to resolve 



this warning message right away by using the Read From… button and choosing the MasterTemplate 15 
Linked Files folder. ArchiCAD will search within that folder, and find the PDF files and relink them. Later, 
when you save the TEMPLATE, all of this will be remembered, so you won't have to deal with them again 
(unless you move the files or decide to change the references). 
 
After you finish opening up the TEMPLATE file, go to the Hotlink Manager (File menu > External Content 
> Hotlink Manager) and relink the Hotlink references to the file locations on your hard drive or network. 
Highlight each one of the files in the list, one by one, and use the Relink…from file button, then navigate 
to the MasterTemplate Linked Files folder and select the appropriate file (NOTE: if you can’t “see” listed 
any files inside the MasterTemplate Linked Files folder, change the file type from MOD to PLN from the 
popup menu). Repeat for the other hotlinks, then click OK to proceed with updating the links.



Changes, Updates and New Features in MasterTemplate 15 
 

1) AMT LEGENDS AND FAVORITES UPDATED FOR ARCHICAD 15 
 
The AMT Legends were revised for compatibility with ArchiCAD Library 15. Most of the existing 
elements found their corresponding item in the AC15 Library as soon as that library was loaded. 
However, a number of AC14 parts had to be manually swapped out for their new equivalents in the 
AC15 library. The labels for the Legend elements in the Quick Rooms and Parts Matrices were 
updated to refer to AC15 names. The new more powerful Shower Cabin 15 object was substituted for 
the previous multi-element shower assembly in several Quick Rooms and added to the Restroom 
Matrix. 

The elements in the Favorites palette were also updated as needed for compatibility with ArchiCAD 
15. 

2) CUSTOM LIBRARIES EMBEDDED 
 
We continued refining the process of embedding all custom library parts into MasterTemplate. In 
AC13 and AC14, there were some issues, but in AC15, this works beautifully without any problems. 

In the USA version, there are a small number of custom parts; in the INT version there is a much 
larger number since we include a working copy of the USA-based Detailer Library for speeding up the 
creation of Detail drawings. 

3) GENERAL NOTES AND SPECIFICATIONS – PAGE SETUP 
 
The word processing document for General Notes and Specifications has been renamed to Master 
Specifications Full Page.doc. It has been reconfigured so that each page in Microsoft Word shows an 
entire layout sheet (divided into multiple columns) rather each Word page representing just a single 
Layout column. This simplifies maintenance and revisions of the general notes, since only one 
Drawing is placed on each Layout Sheet, rather than one per column.  
 
Due to limitations in Microsoft Word (the maximum page dimension is 22”) the Page Setup uses a 
custom page size that creates a page image reduced to 50% of its intended output size. The font size 
is reduced accordingly from 10 point type to 5 point. Similar size adjustments were made for the 
International version. 
 
This boilerplate template file is used as the structure for your General Notes and Specifications; you 
can paste in your typical notes into this file, or create them in this container. This file is then printed or 
saved as PDF, and placed in MasterTemplate at 200% size (to compensate for the 50% reduction in 
Word described above).   
 
The text in the boilerplate Word document has been updated to describe the new strategy. You will 
find the Word document and the corresponding PDF file inside the MasterTemplate Linked Files 
folder. In MasterTemplate itself, the general notes occupy three sheets starting on Layout sheet A.02 
GENERAL NOTES & SPECIFICATIONS in the small project set or A1.02 in the larger project set. 

4) TITLE SHEET – TEXT BLOCK SIMPLIFICATION 
 
The Project Data and Project Team areas on the Title Sheet had formerly been composed of a 
multitude of small text blocks, some with standard text descriptions (e.g. “Zoning”, “Site Area”) and 
others with Autotext linked to the File menu > Info > Project Info data. Many of these text blocks were 
locked to prevent accidental changes. 
 
This arrangement was cumbersome and confusing. The multiple individual text elements have been 
replaced with integrated text blocks that combine both standard text and autotext data. Indentations 
and tabs recreate the graphic look of the earlier arrangements. This will be much simpler to work with, 



since data entered into the Project Info dialog will flow into the text blocks as before, while the overall 
text contents and sequence may be edited as desired more easily. 

 
5) NEW ARCHICAD 15 RENOVATION METHODOLOGY INTEGRATED 

 
A major effort was made to integrate the new Renovation methodology introduced in ArchiCAD 15 to 
MasterTemplate. Ultimately, this new technology will greatly simplify the process of developing and 
documenting remodel and renovation projects. 
 

• TIP: For a guide to how to approach renovation and remodel projects with MasterTemplate 
15, please see the Suggested Renovation Project Workflow section below. 

 
RENOVATION FOLDER IN THE VIEW MAP 
A new RENOVATION folder has been created in the View Map, situated below the folder with 
Construction Document Plan views and above the Section clone folder. 

Inside the RENOVATION folder are several clone folders with different Renovation Filters active that 
may be used depending on your preferences and project requirements. One of these is set for 
“Existing Plan”, one for “Demolition Plan”, and one for “New Construction” – which shows all elements 
(existing, demo and new) with override styles for demo and new elements. In addition, a clone folder 
is set up for Existing elevations that may be used to study, compare, place on Layouts or present 
these elevation drawings. 

NOTE: All Views in general are set to use the “Existing Plan” Renovation Filter, which makes 
everything work simply and easily for new buildings. For remodel projects, most of these Views 
should be changed to use the “Planned Status” or “New Construction” Renovation Filters. See the 
Suggested Renovation Project Workflow for our recommended workflow. 

LAYER CHANGES 
Since the new Renovation tags and filters handle turning on an off elements for demolition plans, 
certain layers and layer combinations were removed since they are no longer needed. These include: 

 
LAYERS DELETED 

• A | DEMOLITION UPPER | 3D 
• A | DEMOLITION | 3D 
• U | DRAWING | DEMOLITION 

 

LAYER COMBINATIONS DELETED 

• CONDOC DEMOLITION 
• MODULE ADDITION ONLY 
• MODULE EXISTING ONLY 

RENOVATION FILTERS 
The standard Renovation Filters were revised slightly for MasterTemplate. Graphisoft sets elements 
in the “To be Demolished” status to be a yellow color in the 02 Demolition Plan and the 04 New 
Construction filters. This yellow pen was not very legible against the light tan background color that 
MasterTemplate uses, so we changed these elements (in the Renovation Filter Options… > 
Renovation Override Styles dialog) to be a light blue pen color and a matching material for 3D 
viewing. In addition, the Line Type option was set to Hidden Line so that the elements would show up 
with a linetype that would clearly contrast existing and new elements when plotted, and the Fill 
Background Color was set to transparent. 

 



 
 

The New Elements Override Style was changed to improve clarity. The Fill Type override was turned 
off for two reasons: it obscured the actual wall construction type, since it changed the wall from a 
specific composite to a simple mono-element fill; also the fill type set by Graphisoft in the USA 
version was an odd insulation type fill, which looked very strange on the plan drawings. 

 
 

The Existing Elements Override Style was not modified; the override for existing elements is actually 
not used in any of the standard Renovation Filters. 

A sixth Renovation Filter was added called 06 Show All, which turns on all three categories of 
elements (Existing, Demo and New) without overrides. This is used primarily to allow the Interactive 
Legends to show all types of elements for use with the eye-dropper. 



 
 

A set of exported Renovation Filters is supplied in the MasterTemplate 15 Supplemental Files folder; 
these may be imported into a customized template to set the filters to matching standards. 
 

NEW COMPOSITE WALL TYPES 
In the Renovation filters dialog, you may set elements in each category to be displayed in a normal 
fashion, or in an alternate style based on the Renovation Override Style for that category. While there 
are a variety of override options, there is a limitation that may be a particular issue for legibility of new 
construction walls with a composite structure. 
One of the override options is to replace the Fill for elements in a particular category (such as new 
construction) with any standard Fill; this can be a poché (e.g. 50%) or a pattern. Unfortunately, when 
this is activated, composite walls lose their separator lines and appear with a simple mono-element 
fill.  

This means that a standard composite wall set as new construction may appear either as “normal” 
(i.e. not contrasting to existing construction, other than pen color, which may not be visible with 
monochrome black-only plotting) or “filled” (which means that the wall type will not be clear). 

To improve legibility of new construction composite walls, we have been experimenting with creating 
additional wall types. In AMT15, there are a handful of new wall types that are basically duplicates of 
standard composites, but with the central core framing set to be filled with a poché fill matching the 
Renovation Override Style for New Construction (i.e. using a red pen). 



To see how this approach works, please study the Sample Project and activate the NEW & DEMO 
PLAN, which uses the New Construction Renovation Filter. You will see the core of the new 
construction walls with a red fill; they are still clearly seen as composites matching the other exterior 
walls, yet the red color identifies them as new construction. These walls also have the parameter 
checked in the Floor Plan Display > Cut Surfaces > Cut Fill Background Pen to “Apply Structure’s 
Settings” in order to ensure that the special composite fills are displayed properly. 
 

 
 

In AMT15, we have not attempted to create new wall types in this fashion for all composite walls; we 
have only done it for a handful of walls to illustrate this approach. If you would like to use this method, 
it is suggested that you create new wall types in your project only for composite wall types actually 
used as “new construction”. 

 

INTERACTIVE SCHEDULES UPDATED TO USE RENOVATION FILTERS 
There are a several door and window schedules in MasterTemplate that are set up to show either all 
elements, new elements only, or existing elements only. The methods previously used for these 
schedules involved setting criteria by ID. For example, to show existing elements, only those with ID 
starting with “X” were included. To show new elements only, the criteria specified ID’s starting with 
“D” or “W” depending on whether the schedule was for doors or windows. 

The interactive schedules now permit criteria to reference the Renovation Status of elements. The 
schedules for New and for Existing now are set to use the Renovation Status as a criteria to include 
only the appropriate elements. 

 



6) LAYERS AND LAYER COMBINATIONS OPTIMIZED 
 
Layers and Layer Combinations have been optimized in MasterTemplate 15 based on our analysis of 
best practices usage. As mentioned above, several layers and layer combinations were deleted due 
to the new Renovation methodology. 
 
NEW LAYERS 

Two new layers were added: 

• M | DUCTS + FLUES + VENT PIPES.3D – for these types of mechanical system items 
• U | DRAWING | BASE SHEET – for annotation that will be sent to consultants using the 

CONDOC | SIMPLE BACKGROUND layer combination. 

 
RENAMED LAYERS 
Two layers were renamed to make them sort near the top of the layer list for faster access: 

• * SPECIAL | TEMPORARY HIDE (was Y | SPECIAL | TEMPORARY HIDE) 
• * TRASH - RECYCLE BIN (was Z | TRASH - RECYCLE BIN) 

Sometimes users ask about the intended function of these two layers. The TEMPORARY HIDE layer 
is used to hide elements that one does not plan to discard. The TRASH layer is for elements likely to 
be discarded; the function is similar to the Mac OS Trash or Windows Recycle Bin – you can drop 
elements into this layer, then later decide to delete all or most of the elements, rather than deleting 
them right away.   
 
LAYER COMBINATIONS FOR DETAILS AND WORKSHEETS  
The Details clone folder had been set to use a layer combination called DETAILS | WORKSHEETS / 
SCHEDULES (AC LAYER); this turned off all layers except for the ArchiCAD layer. The original 
reason for this was based on the idea that almost all details are created with only one intended 
drawing output, so it seemed superfluous and perhaps problematic to have elements on different 
layers that could accidentally be turned off. 
The intended workflow was for the user to select all graphics in the Detail drawing immediately after 
creation, and use the Edit menu > Edit Selection Set command to change everything to the ArchiCAD 
layer. 

However, many users found this setup confusing, since they would create a new Detail drawing and 
see all the graphics copied from the original Section (or wherever the source view of the detail was 
called out from), then later they would return to that View in the Detail clone folder and find that most 
or all of the Detail graphics were missing. 
Since this has caused unnecessary confusion, a different approach is used in AMT15: the layer 
combination referenced by the Details clone folder has been renamed DETAILS + WORKSHEETS 
and now has most layers visible and unlocked (with the exception of the TEMPORARY HIDE and 
TRASH layers). This means that in general all elements copied or created in the Detail drawing will 
be visible as the Drawing is placed onto a Layout. 

Sidenote: Interactive Schedules are set to use a Layer Combination, but when you select either 
the Schedules clone folder or an individual schedule and click the Settings button, you will see 
the Layer Combination is greyed out. The layer combination is recorded based on the settings of 
the most recently open drawing window when one creates the schedule. The only way to change 
this is to open up a schedule, change the Layer Combination, then click the Settings button and 
use the Get Current Window’s Settings button in the top of the Settings dialog box. In 
MasterTemplate 15, the Schedules use the Layer Combination called SHOW & UNLOCK ALL. 

 



SHELL TOOL LAYERS 

The new Shell tool in ArchiCAD 15 can be used for a wide variety of shapes and forms. One of the 
common applications will be to create complex roof geometries, and another will be to create building 
enclosure walls. 

Graphisoft does not add any new layers specifically for the Shell tool in the standard template. In 
MasterTemplate 15, we have decided that it will be useful to add two special layers for Shell 
elements: 

• A | SHELL | ROOF 
• A | SHELL | WALL 

The A | SHELL | ROOF layer is set to show in exactly the same way as the A | ROOF | LOWER, 
while A | SHELL | WALL is patterned after the A | WALL | EXTERIOR layer. However, by creating 
these two additional layers, more options will be available for isolating these elements, which may be 
useful given how complex the shapes and forms may become. 

For Shells that will be used as general “elevated” modeling elements that should be seen in any 3D 
context (Section, Elevation, 3D Window, etc.) but NOT on the floor plan, we suggest using the Y | 
SPECIAL | MODELING ELEMENTS (VISIBLE) layer that is set for exactly that usage. For Shells that 
will be used for floors, terrain or hardscape, it should be sufficient to use the standard layers set up 
for those purposes. 

Since ArchiCAD 15 is brand new, this analysis of layer usage for the Shell tool is our initial attempt at 
an optimized system, and of course may be reworked by users as desired. 

7) SAMPLE PROJECT FILE REVAMPED 

In AMT15, the Sample Project file has been extensively reworked to study and demonstrate the new 
Renovation methodology. In addition, all the library parts were swapped out for ArchiCAD 15 versions 
to simplify library management, and all custom library parts are now embedded. For the convenience 
of International users, in the INT version of MasterTemplate, ALL the library parts are now embedded, 
since the project is based on the USA library. 

Most of the Views are set for Planned Construction, so they illustrate the final design of the building. 
However, in the View Map there is a folder called DEMO and EXISTING PLANS that illustrate 
different variations of floor plans that can be produced. You’ll see several of these variations side-by-
side on the Layout sheet A.06 FLOOR PLANS. 

In particular, please note the use of the special composite wall types with the core pochéd to improve 
legibility in the New Construction filter.  

Look for the special Labels and Fills that are shown only on specific Renovation Filters. In the 
element settings dialog under Tags and Categories, each element can be set to be visible (“Show on 
Renovation Filter”) on All Relevant Filters or a specific Filter only: 

  



SUGGESTED RENOVATION PROJECT WORKFLOW 

As in the standard Graphisoft ArchiCAD 15 template, in AMT15 all the Views in the View Map are set for 
the Existing Plan Renovation Filter. The only exceptions in AMT15 are the special Views in the 
RENOVATION folder. 

The default status of elements in the Renovation palette is set for “Existing Status.” This means that all 
elements drawn will be considered “existing” rather than demo or new, unless you select them and 
change their category. 

This setup “bypasses” the Renovation Filter technology, and gives the same results as in previous 
versions of ArchiCAD, simplifying the transition of existing users to ArchiCAD 15. It works well for projects 
that are new buildings, but requires reworking for renovation and remodel projects. 

ArchiCAD 15 is brand new, so we don’t have any practical experience to guide us in this process. 
However, after study and discussion, we have come up with a suggested renovation workflow for 
MasterTemplate (and other) users. This quick guide is subject to revision based on our experience over 
the next few months, as well as user feedback. 

1) Start a project using your office custom version of MasterTemplate as usual. Develop a model of 
the existing “as-built” building and site as desired. This can be somewhat conceptual or highly 
detailed; it will be possible to refine these existing elements and add more details as information 
becomes available at any point during the design process. 
 

2) When you are ready, select relevant elements and change their status to To Be Demolished or 
New Construction. You may also change the default status of elements in the Renovation palette 
to these categories so that (until you change it again) all newly created elements will be put in this 
category. 
 

3) After you have some elements in more than one renovation category, it may be a good time to 
change the settings of most of the Views in the View Map from Existing to either New 
Construction (which will show existing, demo and new elements in different colors and styles all in 
one drawing) or Planned Status (which will show the final design of the building without 
differentiation of existing elements that remain from the new elements that were added; and of 
course will hide the elements that are to be demolished). 
 

4) If you are using the Planned Status option or a similar variation, then you may wish to create and 
show Demolition Plans on the same or separate Layout sheets. These Demolition Plans are set 
up in MasterTemplate in the RENOVATION folder of the View Map; some of these plans are pre-
placed onto the appropriate layouts. 
 

5) You may study, compare and present different phases of the building by manually changing the 
Renovation Filter in the Renovation palette, or by double-clicking on different Views in the View 
Map that are set to different Renovation Filters. You may even use alternate filtered views as 
Trace References. 

TIP: To simplify step 3, you may select several Views or Clone Folders and click the Settings 
button, and change the Renovation Filter for multiple items at once. Be aware that this will not 
work if you select “normal” folders in the View Map; the Settings dialog will only be accessible if 
your selection only includes Views and Clone Folders. You may select one item and shift-click to 
select several in a row, or use CTRL-click or Command-click to add or take away individual items 
from the selection. 



MASTERTEMPLATE UPGRADE GUIDE 

Integrating MasterTemplate 15 with Your Existing Template  
There are two basic approaches for integrating the new version of the ArchiCAD MasterTemplate with 
customized templates created on earlier versions.  

1) Start over with the new ArchiCAD MasterTemplate 15, and customize it again. This approach is ideal 
for users who have not done much customization to MasterTemplate. 

2) Add the new components of AMT 15 to your existing template. This is best for experienced users who 
have done a lot of customization that they don't want to repeat. 

3) If you are upgrading from a version earlier than AMT 12.1 (e.g. AMT 12, 1.1 or 1.0), the choices are 
similar, however option 2 becomes more complex because many features were added to the file structure 
in AMT 12.1. 

TIP: For options 2 or 3, always save a copy of your existing (older) template before creating your new 
version. That way, you’ll have it available if for any reason you need to refer to it, or need to work in an 
earlier version of ArchiCAD. 



1) UPGRADE GUIDE: How to Integrate Previous Customization into 
MasterTemplate 15 
If you only modified the standard MasterTemplate a small amount, then it may be best to start over with 
the new AMT 15 and rework it again to suit your needs. The simplest way to copy and reuse what you 
changed in AMT is to open up two sessions of ArchiCAD 15. 

In one session, open the standard MasterTemplate 15 TEMPLATE.tpl file. We suggest you immediately 
save this under a new name specific to your office, so that you don't overwrite the standard base version 
of the template in case you need to access it again. Choose the option to Save As an ArchiCAD Template 
(TPL format) so that the file will be usable as a Template file rather than as a PLN project file. We’ll call 
this your New MasterTemplate. 

In the other session of ArchiCAD 15, open your own custom template, the reworked version of an earlier 
MasterTemplate TEMPLATE.tpl file. We suggest you do a Save As for this template (which you have just 
opened up in ArchiCAD 15, perhaps for the first time). Use a new name so you won’t risk overwriting what 
you were using for a previous version of ArchiCAD. We’ll call this your Custom MasterTemplate. You can 
save this as either a TPL or PLN file, since we’ll only be using this as a source reference for copying 
information, then discarding it. 

Layout Masters 

You most likely have adjusted some or all of the Layout Masters. In your Custom MasterTemplate, go to 
the Layout Book and open up the Masters folder, then double-click on the first Master that you have 
customized to open it up. Activate the Arrow tool (if it's not already) and Select All (CTRL-A or CMD-A), 
then Copy to the Clipboard. Switch to your New MasterTemplate (the other session of ArchiCAD) and find 
the same Layout Master; Select All and Delete the contents; then Paste in the contents that you Copied 
from the Custom MasterTemplate file. 

Repeat this for each Layout Master that has been customized. If you deleted any Layout Masters in your 
Custom MasterTemplate in order to shorten your Master list, you may want to delete the corresponding 
ones in your New MasterTemplate. 

Schedules 

If you have added or customized Schedules in your Custom MasterTemplate, you can save these as XML 
files that can be imported into your New MasterTemplate. Double-click one of the entries in the Project 
Map > Schedules > Element list. Click the Scheme Settings… button and review the Schemes listed, and 
highlight one that is new or revised. Click the Export… button to save as an XML file; choose a folder to 
store it that you'll be able to locate easily, and give it an appropriate name. Repeat the Export action for 
each schedule in the list you want to transfer. 

Switch to your New MasterTemplate file, and open up one of the Schedules, then click the Scheme 
Settings… button. Click the Import… button and locate the folder in which you saved the XML files. 
Choose the first one and Import it. Repeat for each one in the folder. 

You may find you have redundant schedules: ones from AMT 15 with the same names as those you 
imported from your Custom MasterTemplate file. Review each pair of schedules that has duplicate names 
and figure out which one is "yours", and then use the Delete button to get rid of the other. 

On each Layout with a Schedule that refers to one that you have deleted and replaced, select the 
Schedule and right-click, then choose Link Drawing To. Choose the option at the top for "an internal View" 
then select the appropriate Schedule from the SCHEDULES (CLONE) folder. 

Element Attributes (Materials, Fills, Composites / Wall Types, etc.) 



If there are any Attributes you have added, such as Materials, Fills, Composites / Wall Types, etc., you 
can use Attribute Manager to transfer them. 

In your New MasterTemplate, open the Options menu > Element Attributes > Attribute Manager. Then on 
the right side of the Attribute Manager dialog box, click the Open… button and browse for your Custom 
MasterTemplate. 

You will be able to select Materials, Fills, Wall Types, etc. from the right side file (your previous template), 
and Append them to the left side (the New MasterTemplate file you are customizing). Do not use the 
Overwrite button unless you know exactly what this means and feel that it is appropriate. 

Other Customization 

There are many ways to customize MasterTemplate. If you choose to follow this method (transferring 
your custom elements manually from your old Custom MasterTemplate to the New MasterTemplate file), 
you will have to go through your Custom MasterTemplate manually and copy each element or area that 
you've modified, then go back to the New MasterTemplate file and paste them in. 

Remember that you do not have to get this "perfect" in one session. You should retain the old Template 
file in case you need to access it later. You can always go back and get something you missed. 

When you are done (for now), be sure to save your file as a TPL (if you haven’t already). Then to test it, 
choose File menu > New and select Use a Template, then Browse… for New MasterTemplate TPL file. 
You should then get an untitled copy of the new template, and see all of your modifications in this untitled 
PLN file. The next time you create a new project file, this template TPL file will be the default in the 
popup, so you won’t have to browse to select it. 



2) UPGRADE GUIDE: Integrating the New MasterTemplate 15 Features into 
Your Highly Customized MasterTemplate 12.1, 13 or 14 File 
If you are an experienced user and have done a lot of customization to MasterTemplate, you may prefer 
to add to your existing template some or all of the new features of AMT 15. That way you can choose 
exactly what you wish to add or change. 

We suggest you review the new features outlined in these Release Notes carefully to understand what 
has been added or modified in AMT 15. Open up the standard AMT 15 Template and study it, and see 
how all the new things work. Then choose what you want to add to your own template, and use methods 
similar to the previous section to transfer what you wish. 

As with any project file, to move your Custom MasterTemplate forward, you may simply open it in 
ArchiCAD 15 and save it. This will now be an ArchiCAD 15 file. We suggest you save it with a new name 
or in a new folder, to avoid overwriting the earlier template file in case you need to do any work in your 
earlier version of ArchiCAD. 

Initially, this New MasterTemplate will reference the earlier ArchiCAD Library. You will need to use Library 
Manager to switch it to use the ArchiCAD 15 Library, plus (at least temporarily) the ArchiCAD Migration 
Libraries folder (which you’ll find in the AC15 folder). To get a “clean” template, you’ll need to switch out 
all parts in your template or Legend that refer to legacy libraries. In MasterTemplate, the references to 
library parts are primarily found in the Interactive Legends. 

Interactive Legends 

The Interactive Legends from earlier versions of AMT used the ArchiCAD Libraries current at the time. It 
is not generally a good idea to migrate templates forward with references to these legacy library parts, 
since it requires loading both the ArchiCAD 15 Library and Migration Libraries for every project. It’s better 
to update the Legend to use only the 15 Library plus specific custom parts you wish to use (which 
includes AMT-supplied parts as well as any of your own). 

To resolve this issue in your Custom MasterTemplate, you may: 

• Switch the Interactive Legends to use the new AMT 15 Interactive Legends based on the 
ArchiCAD 15 Library, or 

• Selectively bring in whatever parts of the new Legends you find useful. 

If you haven’t customized the Legends, simply relink the Hotlinked Module for the Legends in your 
template to use the AMT 15 version. Open the File menu > External Content > Hotlink Manager, then 
select AMT Legends (USA/INT) [14, 13 or 12.1].pln from the list, click Relink, and browse for the new 
version of the file. You may need to switch the popup menu for file type to PLN file in order to see and 
select the AMT Legends USA 15.pln file. 

If you have customized the Legends, then you’ll need to copy and paste between your Custom Legend 
and the New Legend. Open up the AMT 15 LEGEND file and copy whichever parts you wish to use. 
Paste them into your own version of the Legends, and rearrange the Legend group positions as desired. 

For every part in your custom Legend file that is based on a legacy library, you should switch it to use the 
new library. Select it and in the Object (or Window or Door) Settings dialog, navigate to the corresponding 
part in the AC 15 Library, and click to switch to that part. Adjust the parameter values to get it the way you 
prefer. 

If you wish, you may use parameter transfer: hold down Option-Command or ALT-Control to get the 
syringe, and then click with the syringe to switch to the new part while transferring the values of all 



corresponding parameters. Verify that your part looks correct in both the 2D and 3D previews, and then 
click OK. Repeat for every part referencing a legacy library. 

Once you have cleaned up all references to legacy libraries, return to Library Manager and remove the 
Migration Library. If the Library Loading report shows missing library parts and you see the special dots 
indicating missing parts on your floor plan, make a note of what you need to fix then reload the Migration 
Library and swap these legacy parts for current ones. Check it again, and repeat until you have a clean 
Legend that uses only the AC15 Library and has no missing library parts. 

TIP: In ArchiCAD 14 and 15, library management has been improved, and you may accomplish 
migration of legacy parts (the task in the preceding paragraph) a little more simply than before. 
Instead of removing the Migration Library from the list to test if there are any remaining parts to 
migrate, you may highlight that library in the list then click on the little “i" [information] button 
below. You’ll get a new dialog box that shows which parts from that library are actively placed into 
the current file. Then you can use Find and Select to locate them, and replace them with 
equivalents from the ArchiCAD 15 Library (or you may embed them into the file). 

If you have an Office Favorites HLM module separate from the main Legend PLN file (as introduced in 
AMT 12.1), you will need to open that up and update it to use the ArchiCAD 15 Library instead of an 
earlier ArchiCAD Library. To open the Office Favorites file, you may select it in the File menu > External 
Content > Hotlink Manager, then click Open in Separate ArchiCAD. Follow the same process as above. If 
you wish, load the MasterTemplate 15 LIBRARY and embed its active parts into the file. 

If you have a Project Favorites HLM module, be sure to check it for legacy parts, then save a version in 
ArchiCAD 15 format. OPTIONAL: embed the library parts to make this file self-contained. 

For simplicity, put all your Hotlink Modules (the LEGEND as well as Office Favorites and Project 
Favorites) into the same folder as your Custom MasterTemplate for ArchiCAD 15, or into a subfolder of 
Linked Files. 

AMT Library 

The AMT library has been partially updated, and the parts that are actively in use are now embedded into 
the Legend PLN files. Library management will be simplest if you update your Hotlinked Module 
references in the File menu > External Content > Hotlink Manager to use the new Legend files. Then the 
AMT library parts will automatically be loaded directly from the Hotlink files. 

After updating the Hotlinks, for the USA version you may remove the reference to the old AMT Library, 
since it is not necessary.  

However, in the International version, for access to parts in the Detailer Legend, you will still need to load 
a linked library. In Library Manager, replace the earlier MasterTemplate Library reference and use the 
MasterTemplate 15 INT LIBRARY folder (located in the MasterTemplate Supplemental Files folder). After 
loading this library, you may embed this folder using Library Manager if you wish. 

Note for advanced users: Please see the technical note on library management at the end of this 
document for additional options. 



3) UPGRADE GUIDE: Migrating from MasterTemplate 12 or earlier 

The Interactive Legend was substantially expanded in MasterTemplate 12.1. If you are upgrading from a 
version of MasterTemplate prior to AMT 12.1 (AMT 12, 1.1 or 1.0), it is simplest to use AMT 15 and 
repeat your customization (see section 1 above). 

However, if you did a lot of customization, you may choose to add selective parts of the new Legend 
system. Follow the general guidelines in section 2 above. However, since many enhancements were 
made to the file structure and the Legend layout in AMT 12.1, there are additional steps if you wish to 
take full advantage of all the innovations in the current MasterTemplate. 

The following notes are adapted from the AMT 12.1 Release Notes, and explain how to add in the new 
features introduced in AMT 12.1 to your version of the Legends and the template itself. 

Interactive Legend Expansion and Reconfiguration 

The Legend file itself was substantially expanded in AMT 12.1 with the addition of Quick Rooms (room 
arrangements that may either be studied or copied into your project to speed up preliminary design 
layouts) and Matrixes (groups of related objects). In AMT 12.1 and later, these new sections of the 
Legend are also referenced in saved 3D Views and 3D Documents. 

You may replace your own Interactive Legend file with the new one in AMT 15 (see notes in step 1 
above). Alternatively, you may copy and paste parts of the current Legend into your own version, or the 
reverse (adding in your components into the AMT 15 Legend). Be sure to rework your Legend to use the 
current Library (see step 2 above) as part of the update process. 

Legend Placement on Ground Floor 

If you want to use the concept of 3D Views and 3D Documents with your custom Legend, we suggest you 
move the Legend from the -1 Story to the Ground Floor. This will reduce the story-offset issue when using 
the eye-dropper on Legend elements in 3D (see the explanation in the section on 3D Views and 3D 
Documents in the AMT 12.1 Release Notes). You may either Cut the Legends from the -1 Story and then 
Paste them onto the Ground Floor, or delete them from the lower story and place them fresh on the 
Ground Floor. 

If you move the Legends from one story to another, you will need to recreate the Views of the Legend in 
the View Map that refer to the different sections of the Legend. This is because each View, once created, 
is linked to a specific source location (in this case, the floor plan story) which cannot be changed. Zoom in 
on each area of the Legend in its new location (story), and select the Save Current View option from the 
bottom of the View Map, then name the View appropriately. 

Legend Worksheet 

To use the new Worksheet access for the Legend, simply create a new Independent Worksheet. You 
don't have to draw anything in it. Open this worksheet, and then right-click on the View that refers to the 
Interactive Legend from the Plan, and choose Show as Trace Reference. Then in the Trace and 
Reference palette, choose the option to show the Reference in Original Color. 

In this worksheet, to quickly jump to specific areas of the referenced Legend, go to each area of the 
Legend then use the Zoom popup in the bottom left area of the worksheet window (the small triangle next 
to the percentage zoom value), then choose Save Current Zoom… and name it based on the Legend 
section name. Repeat for each zoom you wish to record - perhaps one overall zoom and as many as 20 
individual ones to point to each Legend area. 



Create at least one View in the View Map to reference the Worksheet with the *PRELIMINARY DESIGN 
layer combination, and click the checkbox to Ignore Zoom when opening the view. This will bring up the 
Legend Worksheet to the last zoomed position. 

You may create multiple zoomed Views in the View Map for the Worksheet itself, as we did in AMT 12.1 
and 13, but this is not actually necessary. You may simply open the Worksheet from the View created in 
the previous paragraph, and use the Zoom popup to gain quick access when a different part of the 
Legend is needed. 

You may also open the Worksheet from the Project Map, or using Go To Last Worksheet from the context 
menu, Toolbar popup, or keyboard shortcut. This will bring up the Legend without altering the active 
Layer Combination (as would happen when you double-click a View). 

Legend Views - 3D 

To create the saved 3D Views of the Legend, activate one of the original (or recreated) Views that goes to 
the Legend on the Plan (not the worksheet version). Then draw a marquee around a section of the 
Legend, and choose Show Selection/Marquee in 3D. That should give you a 3D view of the Legend 
grouping you chose. Orbit around until you get an angle you like. Save as a new View in the View Map, 
and repeat for each Legend area that you wish to access. Make sure you use an appropriate Layer 
Combination when creating the 3D Views. 

You can create your own 3D Documents for these 3D Views of the Legend groupings as well. Once you 
have a 3D View that you wish to use, simply right-click in empty space and choose the Capture Window 
for 3D Document… command. Give it an appropriate name, and it will show up in the Project Map as a 
new 3D Document. You'll need to do one additional step: save the view of the 3D Document in the View 
Map (as usual, clicking the Save Current View button from the bottom of the View Map). 

Office Favorites and Project Favorites 

In the Template itself (as opposed to the Legend file), you may choose to add the Office Favorites and 
Project Favorites modules to the Legend area. These concepts were introduced in AMT 12.1, and may 
simplify your future customization of AMT by focusing it on files that are separate from the main Legend 
file. 

In AMT 12.1 and later, blank areas are included in the main Legend file, and these are used for 
placement of the Office Favorites and Project Favorites. All three are placed into the Template file itself. 
The idea is that: 

• The main Legend PLN is updated rarely (perhaps only when we release a new version of 
MasterTemplate). 

• The Office Favorites PLN may be periodically updated or expanded, and always show the latest 
version for all projects. 

• The Project Favorites PLN file (if used) is copied and separately maintained for each actual 
project file. 

Element Attributes 

When you paste in the new Legend either as a whole, or just the Quick Rooms and Parts Matrixes, the 
new Composite Wall Types, Materials, Fills and Layers are brought into the file automatically. You won't 
need to use Attribute Manager to import them. 

These should also become available in your Template file when the Legend HLM is updated in the Hotlink 
Manager. 



The Layer Combinations for *PRELIMINARY DESIGN as well as the plan for SMALL SCALE drawings 
will not come in during this process. To add or rework layer combinations, you will need to create or 
adjust them manually. Other minor adjustments may be needed to reconcile the handful of new layers we 
added. 

This process of integration does not need to be done all in one session. You may bring in some of the 
new features of AMT 12.1, 13, 14 and 15 into your existing template, then return later to pick up others 
that you missed or have decided to include. 	  

AMT Library 

The AMT library has been partially updated, and the parts that are actively in use are now embedded into 
the Legend PLN files. Library management will be simplest if you update your Hotlinked Module 
references in the File menu > External Content > Hotlink Manager to use the new Legend files. Then the 
AMT library parts will automatically be loaded directly from the Hotlink files. 

After updating the Hotlinks, for the USA version you may remove the reference to the old AMT Library, 
since it is not necessary.  

However, in the International version, for access to parts in the Detailer Legend, you will still need to load 
a linked library. In Library Manager, replace the earlier MasterTemplate Library reference and use the 
MasterTemplate 15 INT LIBRARY folder (located in the MasterTemplate Supplemental Files folder). After 
loading this library, you may embed this folder using Library Manager if you wish. 

Note for advanced users: Please see the technical note on library management at the end of this 
document for additional options. 



4) UPGRADE GUIDE: Technical Note on Library Management for Advanced 
Users 

If you prefer to load the current MasterTemplate 15 library items as a Linked Library, you’ll find the 
following resources in the MasterTemplate Supplemental Files folder: 

• USA template: AMT15 USA LIBRARY 
• INT template: AMT15 INT LIBRARY 

If you have already relinked the Legend Hotlinked Modules to the new AMT 15 version files, you may get 
a report window from the Library Manager that there are Libraries with Duplicate Objects: 

 



To clean this up, simply embed the active parts (as we do in AMT 15): click the Library Manager button, 
then highlight the MasterTemplate 15 (USA or INT) Library folder and click the icon button to “Embed 
Placed Objects of Selected Library”:  

  

After clicking, this dialog will come up, and you should check the box to embed textures and zone stamps: 

 

 


